TIA Portal Module 032-410
Basics of Diagnostics
with SIMATIC S7-1500
Matching SCE trainer packages for these training curriculums

SIMATIC Controllers
- SIMATIC ET 200SP Open Controller CPU 1515SP PC F and HMI RT SW
  Order no.: 6ES7677-2FA41-4AB1
- SIMATIC ET 200SP Distributed Controller CPU 1512SP F-1 PN Safety
  Order no.: 6ES7512-1SK00-4AB2
- SIMATIC CPU 1516F PN/DP Safety
  Order no.: 6ES7516-3FN00-4AB2
- SIMATIC S7 CPU 1516-3 PN/DP
  Order no.: 6ES7516-3AN00-4AB3
- SIMATIC CPU 1512C PN with Software and PM 1507
  Order no.: 6ES7512-1CK00-4AB1
- SIMATIC CPU 1512C PN with Software, PM 1507 and CP 1542-5 (PROFIBUS)
  Order no.: 6ES7512-1CK00-4AB2
- SIMATIC CPU 1512C PN with Software
  Order no.: 6ES7512-1CK00-4AB6
- SIMATIC CPU 1512C PN with Software and CP 1542-5 (PROFIBUS)
  Order no.: 6ES7512-1CK00-4AB7

SIMATIC STEP 7 Software for Training
- SIMATIC STEP 7 Professional V14 SP1 - Single license
  Order no.: 6ES7822-1AA04-4YA5
- SIMATIC STEP 7 Professional V14 SP1- Classroom license (up to 6 users)
  Order no.: 6ES7822-1BA04-4YA5
- SIMATIC STEP 7 Professional V14 SP1 - Upgrade license (up to 6 users)
  Order no.: 6ES7822-1AA04-4YE5
- SIMATIC STEP 7 Professional V14 SP1 - Student license (up to 20 users)
  Order no.: 6ES7822-1AC04-4YA5

Note that these trainer packages are replaced with successor packages when necessary. An overview of the currently available SCE packages is provided at: siemens.com/sce/tp

Continued training
For regional Siemens SCE continued training, please contact your regional SCE contact siemens.com/sce/contact

Additional information regarding SCE
siemens.com/sce
Information regarding use

The SCE training curriculum for the integrated automation solution Totally Integrated Automation (TIA) was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training purposes for public educational and R&D institutions. Siemens AG does not guarantee the contents.

This document is to be used only for initial training on Siemens products/systems. This means it can be copied in whole or part and given to those being trained for use within the scope of their training. Circulation or copying this training curriculum and sharing its content is permitted within public training and advanced training facilities for training purposes.

Exceptions require written consent from the Siemens AG contact: Roland Scheurer roland.scheuerer@siemens.com.

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted or a utility model or design is registered.

Use for industrial customer courses is expressly prohibited. We do not consent to commercial use of the training curriculums.

We wish to thank the TU Dresden, especially Prof. Dr.-Ing. Leon Urbas, the Michael Dziallas Engineering Corporation and all other involved persons for their support during the preparation of this training curriculum.
## Table of contents

1. Goal........................................................................................................................................... 5
2. Prerequisite.................................................................................................................................. 5
3. Required hardware and software................................................................................................. 6
4. Theory .......................................................................................................................................... 7
   4.1 Fault diagnostics and hardware faults .................................................................................. 7
   4.2 Hardware diagnostics ............................................................................................................. 8
   4.3 Diagnostics for program blocks ............................................................................................ 9
5. Task.............................................................................................................................................. 10
6. Planning....................................................................................................................................... 10
   6.1 Online interface .................................................................................................................. 10
7. Structured step-by-step instructions .......................................................................................... 11
   7.1 Retrieve an existing project .................................................................................................. 11
   7.2 Download the program ........................................................................................................ 12
   7.3 Go online ............................................................................................................................ 14
   7.4 Online & diagnostics of the SIMATIC S7 controller ............................................................. 18
   7.5 Online/offline comparison ................................................................................................... 27
   7.6 Monitor and modify tags ....................................................................................................... 30
   7.7 Force tags ............................................................................................................................ 33
   7.8 Checklist ............................................................................................................................. 37
8. Exercise ....................................................................................................................................... 38
   8.1 Task – Exercise .................................................................................................................... 38
   8.2 Planning ............................................................................................................................... 38
   8.3 Checklist – Exercise .............................................................................................................. 39
9. Additional information ................................................................................................................ 40
BASICS OF DIAGNOSTIC FUNCTIONS

1 Goal

In this module, the reader will become acquainted with the tools that support troubleshooting. This module will present diagnostic functions that, for example, you can test with the TIA project from the SCE_EN_032-100_FC-Programming with SIMATIC S7-1500 module. The SIMATIC S7 controllers listed in Chapter 3 can be used.

2 Prerequisite

This chapter builds on the hardware configuration of SIMATIC S7 CPU1516F-3 PN/DP. However, other hardware configurations that have digital input and output cards can be used. You can use the following project for this chapter, for example:

SCE_EN_032_100_FC-Programming_R1503.zap13
3 Required hardware and software

1 Engineering station: requirements include hardware and operating system (for additional information, see Readme on the TIA Portal Installation DVDs)

2 SIMATIC STEP 7 Professional software in TIA Portal – as of V13

3 SIMATIC S7-1500/S7-1200/S7-300 controller, e.g. CPU 1516F-3 PN/DP – Firmware as of V1.6 with memory card and 16DI/16DO and 2AI/1AO
   Note: The digital inputs should be fed out to a control panel.

4 Ethernet connection between engineering station and controller

![Diagram of hardware and software requirements]

1 Engineering station
2 SIMATIC STEP 7 Professional (TIA Portal) as of V13
3 SIMATIC S7-1500 controller
4 Ethernet connection
Control panel
4 Theory

4.1 Fault diagnostics and hardware faults

Faults can be caused by a variety of things.

Two error patterns can be distinguished for faults that occur after a transition to RUN.

1. The CPU goes to or stays in STOP mode. The yellow STOP LED lights up, and other indicator LEDs light up on the CPU, power supply unit, IO modules or bus modules.

A CPU fault has occurred in this case. For example, a module in the AS might be defective or have an incorrect parameter assignment, or a bus system fault might be present.

An interruption analysis will be performed in this instance by evaluating the hardware diagnostics and by reading the module status in the diagnostic buffer of the CPU.

2. The CPU is in faulty RUN mode. The green RUN LED lights up and other indicator LEDs light up or flash on the CPU, power supply unit, IO modules or bus modules.

In this case, a fault may have occurred in the IO devices or power supply.

A visual check is performed initially to narrow down the fault area. The indicator LEDs on the CPU and IO devices are evaluated. The diagnostic data of the faulty IO and bus modules are read from the hardware diagnostics. In addition, a fault analysis can be performed using a watch table on the programming device.
4.2 Hardware diagnostics

The device view in online mode of the TIA Portal provides you a quick overview of the configuration and system status of the automation system.

Figure 1: Online view of device configuration
4.3 **Diagnostics for program blocks**

The project tree window of the TIA Portal in online mode provides you an overview of the programmed blocks of the user program. With the help of diagnostic symbols, a comparison of the program blocks used offline and online is displayed.

![Online view of the Main [OB1] block](image)

Figure 2: Online view of the Main [OB1] block
5 Task

The following diagnostic functions will be shown and tested in this chapter:
- Diagnostic symbols in the online view of the TIA Portal
- Device diagnostics with module status
- Offline/online comparison
- Monitoring and modifying tags
- Forcing tags

6 Planning

The diagnostic functions will be performed using a finished project as an example.
A project in the TIA Portal that was previously downloaded to the controller should be open for this.
In our case, after starting the TIA Portal, a previously created project will be retrieved from the archive and downloaded to the associated controller.
Afterwards, you can start implementing the diagnostic functions in the TIA Portal.

6.1 Online interface

Online diagnostics are only possible when the correct communication connection to the CPU has been set up beforehand. Here, we are connected via Ethernet/PROFINET.
When connecting online, you must therefore set the appropriate interfaces for your automation system.

![Figure 3: Go online](image-url)
7 Structured step-by-step instructions

You can find instructions on how to carry out planning below. If you already have a good understanding of everything, it will be sufficient to focus on the numbered steps. Otherwise, simply follow the detailed steps in the instructions.

7.1 Retrieve an existing project

→ Before we can start the diagnostic functions, we need a project with programming and a hardware configuration.

(e.g., SCE_EN_032-100_FC-Programming….zap).

To retrieve an existing project that has been archived, you must select the relevant archive with → Project → Retrieve in the project view.

Confirm your selection with "Open".

(→ Project → Retrieve → Select a .zap archive → Open)

→ The next step is to select the target directory where the retrieved project will be stored.

Confirm your selection with "OK". (→ Target directory → OK)
7.2 Download the program

→ After the project has been successfully retrieved, the controller can be selected and downloaded together with the created program. (→ ![Download to device])
→ Select the correct interfaces and click "Start search". (
  "PN/IE" → Selection of the network adapter of the PG/PC → Direct at slot ‘1 X1’ → "Start search")

Once "Scan and information retrieval completed" appears, click "Load". (→ "Load")

→ Before downloading can be started, other actions may have to be set (highlighted in pink). Click "Load" again. (→ "Load").
→ After loading, first select the "Start all" check box under Action.

Click "Finish". (→ select check box → "Finish")

7.3 Go online

→ To get started with the diagnostic functions, we will select our controller ("PLC_1") and click "Go online". (→ PLC_1 → Go online)
Once the online connection to the "PLC_1" controller is established, the CPU can be started or stopped with the following buttons. Diagnostic information in the form of symbols will already be available in the project tree and in the diagnostics window.

Symbols for the comparison status in the project tree

The diagnostic symbols in the project tree show a comparison status representing the online/offline comparison of the project structure.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢.svg</td>
<td>Folder contains objects whose online and offline versions are different (only in the project tree)</td>
</tr>
<tr>
<td>🔴.svg</td>
<td>Online and offline versions of the object are different</td>
</tr>
<tr>
<td>🟠.svg</td>
<td>Object only exists online</td>
</tr>
<tr>
<td>🟡.svg</td>
<td>Object only exists offline</td>
</tr>
<tr>
<td>🔴.svg</td>
<td>Online and offline versions of the object are the same</td>
</tr>
</tbody>
</table>
→ Double-click "Device configuration".

(→ Device configuration)

Operating state symbols for CPUs and CPs

→ The graphical representation and device information window show the various operating states of the CPU or communication processors (CPs).

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operating state</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>RUN</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>STOP</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>STARTUP</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>HOLD</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /></td>
<td>DEFECT</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol" /></td>
<td>Unknown operating state</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>The configured module does not support display of the operating state.</td>
</tr>
</tbody>
</table>
**Diagnostic symbols for modules and devices in the device overview**

The graphical representation and Device overview window display the operating states of the various modules, CPU, or communication processors (CPs) using the following symbols.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /> <img src="image2" alt="Symbol" /></td>
<td>The connection to a CPU is currently being established. The CPU is not accessible at the set address.</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /> <img src="image4" alt="Symbol" /></td>
<td>The type of CPU configured and type of CPU actually present are incompatible. During the establishment of the online connection to a protected CPU, the password dialog was terminated without input of the correct password.</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /> <img src="image6" alt="Symbol" /></td>
<td>No fault Maintenance required Maintenance demanded</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>Fault</td>
</tr>
<tr>
<td><img src="image8" alt="Symbol" /> <img src="image9" alt="Symbol" /></td>
<td>The module or device is deactivated.</td>
</tr>
<tr>
<td><img src="image10" alt="Symbol" /> <img src="image11" alt="Symbol" /></td>
<td>The module or device cannot be accessed from the CPU (valid for modules and devices below a CPU). Diagnostic data is not available because the current online configuration data differs from the offline configuration data.</td>
</tr>
<tr>
<td><img src="image12" alt="Symbol" /> <img src="image13" alt="Symbol" /></td>
<td>The configured module or device and the module or device actually present are incompatible (valid for modules or devices below a CPU).</td>
</tr>
<tr>
<td><img src="image14" alt="Symbol" /> <img src="image15" alt="Symbol" /></td>
<td>The configured module does not support display of the diagnostic status (valid for modules below a CPU).</td>
</tr>
<tr>
<td><img src="image16" alt="Symbol" /> <img src="image17" alt="Symbol" /></td>
<td>The connection has been established, but the state of the module is currently still being determined.</td>
</tr>
<tr>
<td><img src="image18" alt="Symbol" /> <img src="image19" alt="Symbol" /></td>
<td>The configured module does not support display of the diagnostic status. Error in lower-level component: A error is present in at least one lower-level hardware component.</td>
</tr>
</tbody>
</table>
Color coding of ports and Ethernet cables

→ The status of ports and Ethernet cables can be diagnosed in the Network view and Topology view.

→ The following table shows the possible colors and their respective meaning.

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No fault or maintenance required</td>
</tr>
<tr>
<td>Yellow</td>
<td>Maintenance demanded</td>
</tr>
<tr>
<td>Red</td>
<td>Communication error</td>
</tr>
</tbody>
</table>

7.4 Online & diagnostics of the SIMATIC S7 controller

→ Double-click "Online & diagnostics" in the project tree.

(→ Online & diagnostics)

→ A CPU operator panel, the cycle time and the memory utilization are displayed in the Online tools on the right side. Switch the CPU to RUN here. (→ RUN)
The working area window contains general information about the CPU. (→ General)

If diagnostic information is available, it is displayed in Diagnostic status. (→ Diagnostic status)
→ Detailed Information on the individual events is displayed in Diagnostics buffer.
  (→ Diagnostics buffer)

→ Next you receive information about the cycle time of the executed program.
  (→ Cycle time)
→ The memory utilization can be seen here in detail. (→ Memory)

![Memory Utilization Graph]

→ Information about the display is also available for the CPU 1516F. (→ Display)

![Display Information]

For unrestricted use in educational and R&D institutions. © Siemens AG 2017. All rights reserved.
The network settings and the status of the PROFINET interfaces [X1] and [X2] can also be displayed.

(→ PROFINET interface [X1] or → PROFINET interface [X2])
In "Assign IP address" under Functions, you can assign the IP address to a controller. However, this is only possible when no hardware has been downloaded to the CPU.

(Functions → Assign IP address)

Under "Set time", you can set the time of the CPU.

(Functions → Set time)
Under "Firmware update", you can update the firmware of the PLC or the display.

(→ Functions → Firmware update)
→ Under "Assign name", you can assign a PROFINET device name to the configured field devices on PROFINET. The device name of the CPU cannot be changed here. It can only be changed by downloading a modified hardware configuration.

(→ Functions → Assign name)

→ Under "Reset to factory settings", you can restore the factory settings for the CPU. After restoring the factory settings, the CPU configuration and the program must be imported again from the inserted memory card. Therefore, the memory card must be formatted before the restoring the factory settings.

(→ Format memory card → Format → Reset to factory settings → Retain or delete IP address → Reset)
→ Finally, the service data can be saved under Functions.

(→ Functions → Save service data)

→ The online connection should be disconnected again before the next chapter.

(→ Online access → Disconnect online connection)

→ The TIA Portal is now back in offline mode. The orange-colored bars and the diagnostic symbols are no longer displayed.
7.5 Online/offline comparison

→ It is often important to know whether the saved data matches the data loaded in the controller. First, remove the negation from the "Safety_shutoff_active" tag at the AND function in the "MOTOR_MANUAL [FC1]" block.

Save the "MOTOR_MANUAL [FC1]" block, but do NOT download it to the controller.

Close the "MOTOR_MANUAL [FC1]" block again.

→ To compare, right-click the "PLC_1" controller and select "Compare", "Offline/online".

(→ Select controller → Compare → Offline/online)

→ The Compare editor online opens.
→ If, for example, block differences are indicated 🔄, first select the block involved. You can then click the 🔄 button to "Start detailed comparison".  
(→ MOTOR_MANUAL → Start detailed comparison).

→ The selected offline/online block will be compared in the code block comparison. A detailed description of the difference is shown in the comparison result.

→ Close the window of the code block comparison.
An action can be selected for the block involved in the Compare editor.

Either the "MOTOR_MANUAL" block will be downloaded from the programming device to the controller and overwritten there or the "MOTOR_MANUAL" block will be imported from the controller and overwritten in the TIA Portal.

Select the "Upload from device" action. (← Upload from device)

Click the "Execute actions" button. (→ Execute actions)

Confirm "Upload from device". (→ Upload from device)

After the upload, there are no more differences. You should now save your project again and close the online connection.
7.6 Monitor and modify tags

→ To monitor and modify tags, you need a watch table.

Double-click "Add new watch table" in the project tree.

(→ Add new watch table)

→ Open the newly created "Watch_table_1" by double-clicking it. (→ "Watch_table_1")

→ You can enter individual tags in the table or you can select the "Tag_table_sorting_station" and the tags to be monitored, and drag them from the Details view to the watch table.

(→ Default tag table)
To have all monitoring and modifying functions available for selection, the following columns can be displayed:

'All modify columns' and 'All expanded mode columns'.

Continue by selecting the trigger timing for the monitoring.

(→ Permanent)

The following monitoring and modifying modes are available:

- Permanent (in this mode, the inputs are monitored/modified at the start of the cycle and the outputs at the end.)
- Once only, at start of scan cycle
- Once only, at end of scan cycle
- Permanently, at start of scan cycle
- Permanently, at end of scan cycle
- Once only, at transition to STOP
- Permanently, at transition to STOP

\[\text{Process image of the inputs}\]

\[\text{"At start of cycle" trigger point}\]

\[\text{OB 1}\]

\[\text{At transition to STOP trigger point}\]

\[\text{"At end of cycle" trigger point}\]

\[\text{Process image of the outputs}\]
Next, click "Monitor all values once and now" or "Monitor all values according to trigger settings". (→ Monitor all)

To modify tags, enter the desired "Modify values". Next, click to "Modify all activated values once and now" or to "Modify all activated values by Modify with trigger condition".

(→ TRUE modifies all activated values by "Modify with trigger condition")

Confirm the warning with 'Yes'. (→ Yes)

The output becomes active even though the programmed conditions are not met.

Note: If the watch table is closed or the connection to the PLC is lost, all modify commands become ineffective.
7.7 Force tags

→ The “Force” function can be used to assign a fixed value to tags. Force values are specified in a similar way as for the "Modify tags" function but, in contrast, are retained after the CPU is stopped. The main differences between "Modify tags" and the "Force" function are as follows: In contrast with "Modify tags", the "Force" function does not allow you to assign values to data blocks, timers, counters and bit memory.

IO device inputs (e.g., IWxx:P) cannot be modified, although they can be pre-assigned by the "Force" function.

Unlike with the "Modify" function, values permanently assigned by the "Force" function cannot be overwritten by the user program.

If you close the force table, the force values are retained. This is not the case with the "Modify" function.

If the online connection to the CPU is interrupted, the tags assigned with the "Force" function retain their value.

→ To force tags, you must first double-click the force table to open it.

(→ Force table)
→ Select the “Q1” operand with address %Q0.0 from the list. (→ Q1)

With forcing, the operands are entered with direct IO access (%Q0.0:P).

Enter the desired force value and activate it.

Click “Start or replace forcing”. The new force request is transferred to the CPU.

Confirm the warning with ‘Yes’. (→ Yes)

Forcing is activated and the yellow MAINT LED on the CPU lights up. In addition, an F on a red background is shown at the top right of the display of the S7-1500.

Note: If the watch table is closed or the connection to the PLC is lost, forcing remains active, and the yellow FRCE LED on the CPU continues to be lit.
If you want to ‘Stop forcing’, simply click "Stop forcing" ( ), and confirm the next dialog with “Yes”.

(→ Stop forcing) ’Yes’ (→ Yes)

Forcing is stopped and the yellow **MAINT LED** on the CPU goes out.

If there is already a force request in the controller, this is indicated by the symbol in the watch table.

If you now click ( ), additional information is displayed. (→ )

The I/O belonging to address ‘%Q.00’ will be forced with the value ‘TRUE’.
→ If there is already a force request in the controller, it can also be displayed and stopped via the online device view. For this, you need to right-click the CPU in online mode of the device view and select "Update and display forced operands".

(→ right-click the CPU → Update and display forced operands)

→ The force table with the current force requests will now be displayed and you can stop these. (→ Stop forcing)
## 7.8 Checklist

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project 032-100_FB-programming… successfully retrieved.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1516F from project 032-100_FB-Programming… successfully downloaded.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CPU 1516F connected online.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Status of the CPU 1516F checked with Online &amp; diagnostics.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Offline/online comparison of blocks in the CPU 1516F performed.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Watch_table_1 created.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Switch on conveyor motor forwards by modifying the output (-Q1 = 1) in watch table.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Switch off conveyor motor forwards by modifying the output (-Q1 = 0) in watch table.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Open force table</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Tag (-Q1:P) entered in force table.</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Switch on conveyor motor forwards by forcing the output (-Q1 = 1) in force table.</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Force output -Q1 to switch off again.</td>
<td></td>
</tr>
</tbody>
</table>
8 Exercise

8.1 Task – Exercise

In this exercise, the MOTOR_AUTO [FB1] function block from chapter SCE_EN_032-200_FB-Programming is to be tested.

The problem here is that the cylinder is in the front end position and thus the enable conditions for switching on the conveyor are not OK.

Using a watch table, the cylinder is to be moved to its rear end position so that the enable conditions for the MOTOR_AUTO [FB1] block become OK.

8.2 Planning

Plan the implementation of the task independently using the step-by-instructions as an aid.
### 8.3 Checklist – Exercise

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project 032-200_FB-Programming… successfully retrieved.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 1516F from project 032-200_FB-Programming… successfully downloaded.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Watch table created and renamed as &quot;Watch_table_cylinder&quot;.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Retract cylinder by modifying the output (-M2 = 1) in watch table.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Cylinder retracted (-B1 = 1)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Reset output for Retract cylinder in watch table again (-M2 = 0).</td>
<td></td>
</tr>
</tbody>
</table>
9 Additional information

You can find additional information as an orientation aid for initial and advanced training, for example: Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software/firmware, at the following link:

www.siemens.com/sce/s7-1500